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1. Noțiuni de bază 
 

PowerPoint este un program care face parte din pachetul Microsoft Office și 

oferă instrumente puternice care ajută la crearea şi organizarea pas cu pas a unei 

prezentări. 

Cu PowerPoint este posibilă crearea diapozitivelor unei proiecţii, a notelor 

vorbitorului, a diapozitivelor imprimate pentru public şi a schiţelor, toate într-un 

singur fişier de prezentare. 

 Prezentarea PowerPoint vine în sprijinul expunerii unei lucrări sau activități. 

Cuprinde de regulă ideile principale, scheme, imagini, diagrame, poze. Se recomandă să 

nu conțină textul integral al unei lucrări, cu scopul de a fi citit de prezentator sau de 

participanți. 

 

1.1. Crearea unei prezentări 

 

Programul PowerPoint se pornește utilizând oricare dintre următoarele metode: 

- clic pe butonul (din bara de start) Start → PowerPoint (în unele variante de windows 

se caută în → Toate programele → Microsoft Office); 

- clic pe pictograma unei comenzi rapide, dacă există una, din spaţiul de lucru sau de 

pe bara de start. 

La pornirea programului PowerPoint se deschide implicit o prezentare 

necompletată, intitulată implicit „Presentation1” (Prezentare1) (fig. 1.).  

Se poate deschide o nouă prezentare prin apăsarea butonului File din bara de 

stare (comandă rapidă) și clic pe „Blank Presentation” (fig. 2a.) sau deschizând meniul 

File → New → Blank Presentation (fig. 2b.). Prezentarea nou deschisă va avea 

numele implicit „Prezentare2” și reprezintă un alt fișier PowerPoint care poate fi 

salvat cu alt nume. Fiecare prezentare poate fi minimizată, maximizată sau închisă de 

la butoanele din dreapta-sus ale ferestrei de lucru. 

PowerPoint furnizează, de asemenea, teme prefabricate. Pentru a schimba 

tema prezentării, aceasta se alege, în funcție de preferințe (vezi fig. 2a și 2b). 

La varianta PP 2010 există separat teme și șabloane. Temele se referă la fundal 

iar șabloanele sunt prezentări prefabricate, care se potrivesc unor situații concrete. 

Se recomandă alegerea șablonului cel mai apropiat ca și concepție de prezentare a ce 

se dorește a se realiza, dar se pot aduce modificări orcând diapozitivelor din șabloane 

conform dorințelor. La PP ulterior 2010 nu mai sunt separate temele și șabloanele. Se 

regăsesc doar teme, iar unele dintre ele sunt de fapt șabloane de prezentări. 

Prezentarea deschisă prima dată (fig. 1.) are doar două casete-text care  

sugerează conținutul primului diapozitiv: titlul și subtitlul. Acestea pot fi folosite sau 

pot fi șterse pentru a crea, de la un diapozitiv total gol, prezentarea dorită.  
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De asemenea poate fi aleasă o temă care are fundalul dorit sau acesta poate fi 

realizat separat. 

 

Atenție: în PowerPoint textul se introduce doar în casete-text. Caseta-text, 

odată completată și formatată, va fi tratată ca un obiect, adică poate fi mutată, i se 

poate atașa animație etc. Asupra conținutului se poate oricând interveni pentru 

corectare sau formatare. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 1. 
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Fig. 2a. 

Fig. 2b. 
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1.2. Elementele ferestrei 

 

În partea superioară a ferestrei PowerPoint se află meniurile şi butoanele 

utilizate pentru realizarea celor mai frecvente activităţi de prezentare (fig. 3.). 

Meniurile cuprind comenzile sau opţiunile disponibile în PowerPoint și sunt 

organizate în bara de instrumente. 

În partea inferioară a panoului se află butoanele de vizualizare ce permit 

afişarea diapozitivelor din prezentare în diverse moduri. La prima pornire a 

programului PowerPoint, prezentarea este afişată în vizualizarea Normal. 

Mesajele care apar în partea inferioară a ferestrei, în zona numită bară de 

stare, descriu ceea ce se vede şi se realizează în fereastra PowerPoint în timpul 

lucrului. 

Pentru a afla informații despre diverse elemente de pe ecran sau diverse 

acțiuni se poate utiliza butonul „Ajutor”. Va apărea o casetă de căutare și răspuns 

pentru solicitare. 
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1.3. Denumirea, salvarea, deschiderea, redenumirea unei prezentări 

 

După finalizarea unei prezentări sau dacă se dorește închiderea fișierului 

pentru prima dată, acesta trebuie salvat sub un nume sugestiv, într-un dosar anume,  

astfel încât informaţiile să fie disponibile și accesibile la următoarea pornire a 

computerului. Salvarea fişierului este similară cu salvarea altor tipuri de fişiere din 

programele Office. Când se salvează pentru prima dată un fișier, se folosește funcția 

„Save as” (Salvare ca), se dă un nume fișierului şi se specifică locația de salvare. 

Salvarea se face pe discul local (hard disk) sau pe orice alt suport (disc extern, stick 

de memorie) (fig. 4.).  

Există posibilitatea să se creeze un dosar/folder nou în care să fie salvat 

fișierul, utilizând instrumente oferite de program în cazul în care nu există deja o 

locație pentru salvare.  

După salvare, o prezentare PowerPoint poate fi redeschisă pentru revizuirea 

conţinutului şi pentru a efectua modificări și completări. Deschiderea se face prin 

dublu clic pe numele fișierului, din locația în care a fost salvat. La închiderea fișierului 

apare o casetă de dialog în care este întrebarea dacă se salvează modificările. Făcând 

clic pe „Da”, modificările se salvează iar fișierul se închide. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 4. 
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Dacă se dorește salvarea prezentării sub un alt nume sau în altă locație, acest 

lucru se poate reaiza folosind funcția „Save as”. 

Ca orice alt fişier Windows, numele unui fișier poate avea lungimea de până la 

255 caractere, dar nu poate conţine nici unul dintre următoarele caractere: 

/ \ > < * ? “ | : ;  

Este recomandat să nu se folosească diacritice sau punct în denumirea fișierului. 

De asemenea, există posibilitatea de salvare a fişierului în alt format (variantă 

mai veche de PowerPoint - ppt, pdf, html, ppsx etc.) utilizând opțiunile din caseta de 

dialog „Save as”. 

 

1.4. Examinarea și imprimarea unei prezentări, închiderea fișierului 

 

După finalizarea unei prezentări PowerPoint, conţinutul său poate fi examinat şi 

imprimat. Pentru a imprima o prezentare se afişează caseta de dialog „Print” (vezi fig. 

5.), din meniul File. În această casetă de dialog se pot modifica setările de imprimare, 

se pot examina datele şi paginile de imprimat, se imprimă întreaga prezentare sau 

doar unele diapozitive. De asemenea se poate selecta modul de poziționare al paginii 

(portret sau vedere) precum și numărul de diapozitive de pe o pagină. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 5. 



POWERPOINT 

2. Introducerea datelor într-o prezentare și formatarea textului și a obiectelor 

 

 
9 Caietele metodistului - 4 

Un fișier poate fi închis prin închiderea prezentării sau părăsirea aplicaţiei 

PowerPoint. La închiderea prezentării curente, programul PowerPoint continuă să 

ruleze, în timp ce închiderea ferestrei determină închiderea automată a programului 

PowerPoint. Închiderea prezentării (nu și a programului PowerPoint) se realizează din 

meniul File, opțiunea Close. 

La închiderea fișierului, dacă prezentarea nu a fost salvată, sau modificările 

realizate nu au fost salvate, programul solicită salvarea înainte de a închide fereastra. 

Când s-a încheiat utilizarea programului PowerPoint este necesară închiderea aplicaţia 

utilizând comenzile acesteia. Nu este recomandat să se oprească computerul în timpul 

executării unui program. 

 

 

 

2. Introducerea datelor într-o prezentare și formatarea 

textului și a obiectelor 
 

 

2.1. Inserarea diapozitivelor, aranjarea diapozitivelor, stabilirea fundalului 

 

 În cazul unei prezentări simple, pe parcursul înaintării în dezvoltarea acesteia 

este nevoie de noi diapozitive. Chiar și când se lucrează pe baza unor șabloane poate fi 

nevoie la un moment dat de diapozitive suplimentare față de cele oferitre de șablon. 

În oricare din aceste cazuri, în orice moment se poate insera un diapozitiv nou 

astfel: în meniul Home (Pornire) avem butonul New Slide (Diapozitiv nou). Când se 

face clic pe acest buton se deschide o fereastră din care se poate alege oricare din 

opțiunile oferite: se poate alege un diapozitiv nou necompletat, un diapozitiv care are 

deja inserate casete-text, în funcție de necesități sau se poate alege duplicarea 

diapozitivului selectat (fig. 6.). Acesta va fi inserat după diapozitivul selectat. 

 Dacă se face clic chiar pe butonul-diapozitiv se va insera automat un diapozitiv 

nou, gol, după cel activ; dacă se face clic pe săgeata mică din dreapta-jos a buronului, 

se va deschide fereastra cu opțiunile submeniului.  
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 Diapozitivele pot fi oricând repoziționate în două feluri: 

- fie în fereastra din partea stângă, Zona cuprinsului diapozitivelor (vezi fig. 3.), unde 

sunt vizibile toate diapozitivele prezentării, în format mic; se face clic pe un 

diapozitiv și se „trage” cu mouse-ul în poziția dorită; 

- fie se trece pe modul de vizualizare „Sortare diapozitive” din bara de stare, 

Butoanele de vizualizare (vezi fig. 3.), sau același buton din meniul Vizualizare, unde, 

de asemenea, se „trage” cu mouse-ul în poziția dorită. 

 Pentru a șterge un diapozitiv, se selectează din Zona cuprinsului diapozitivelor 

(vezi fig. 3.) și se șterge diapozitivul selectat folosind tasta „Delete”. 

 Fundalul ales pentru diapozitiv, dacă este o temă aleasă din temele oferite de 

program, poate fi formatat schimbând gama de culori a temei sau chiar tema însăși. În 

cazul inserării unui nou diapozitiv sau a copierii unui diapozitiv dintr-o altă prezentare, 

fundalul diapozitivului nou se va adapta setărilor din prezentarea în lucru. 

 Într-o prezentare fundalul poate fi identic pentru toate diapozitivele. În acest 

caz, la stabilirea fundalului, dintr-o temă sau creat de proiectant, se folosește 

opțiunea „Se aplică pentru toate diapozitivele”. Dacă se dorește fundal diferit pentru 

unele dintre diapozitive, va fi selectat fundalul pentru fiecare diapozitiv în parte. În 

acest caz, dacă se dublează un diapozitiv, acesta va avea fundalul celui selectat 

pentru a fi dublat. 

Fig. 6. 
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 Fundalul poate fi ales și ca textură sau culoare, sau creat un gradient de 

culoare, după dorința proiectantului, independent de temele propuse, folosind meniul 

obținut prin clic-dreapta pe suprafața diapozitivului, opțiunea Formatare fundal, de 

unde se poate alege varianta dorită. 

 

2.2. Introducerea textului. Formatarea textului și a casetei-text 

 

 Introducerea textului într-un diapozitiv din cadrul unei prezentări se face doar 

în casete-text. Astfel, întâi se inserează o casetă-text (din meniul Insert = 

Inserare), după care se completează textul în aceasta. Se mai poate introduce text în 

diversele forme inserate în diapozitiv. 

 După introducerea textului, caseta-text devine un obiect care se comportă în 

cadrul prezentării ca orice obiect sau imagine inserate în diapozitiv. 

 Pentru accesul la text se dă clic în interiorul casetei-text. Se selectează textul 

și se poate formata dimensiunea și tipul fontului precum și alinierea textului față de 

marginile casetei. 

 Pentru a formata caseta-text se face clic pe conturul ei și se alege meniul 

Drawing Tools (Instrumente de desen) → Format care apare la selectarea casetei, 

sau se face clic-dreapta și din lista de meniu derulantă se alege Format Shape 

(Formatare formă) (fig. 7). 

 Orice casetă-text, după ce a fost formatată și completată cu conținut, este 

tratată ca un obiect și poate fi copiată în oricare alt diapozitiv, ștearsă sau mutată. 

Prin copierea în alt diapozitiv se poate păstra o formatare uniformă a căsuțelor-text 

în toată prezentarea și se economisește timpul de formatare a fiecăreia în parte. 

Textul se poate suprascrie, corecta, formata oricând.  

Se recomandă folosirea de fonturi robuste și o mărime minimă de 18, pentru ca 

textul să fie vizibil în sala de prezentare. 

 

2.3. Utilizarea notelor 

 

 În partea de jos a ferestrei dintr-o prezentare există Zona notelor (vezi fig. 

3). Notele sunt însemnări legate de diapozitivul activ, care cuprind anumite 

specificații legate de diapozitivul activ, fie pentru anumite acțiuni fie ca idei pentru 

prezentare. Notele nu vor fi expuse în momentul derulării expunerii, ele sunt doar 

pentru proiectantul prezentării. Notele pot fi vizualizate în modul View → Notes 

(Vizualizare → Pagină de note) și de asemenea pot fi imprimate împreună cu 

diapozitivul căruia îi sunt adresate. 
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2.4. Inserarea și formatarea imaginilor, formelor, obiectelor, diagramelor 

 

 În PowerPoint se pot insera diverse obiecte din meniul Insert = Inserare: 

imagini, miniaturi, tabele, forme, casete-text, WordArt, antet și subsol, ecuații, 

diagrame etc. (fig. 8.). 

 După inserare, orice obiect trebuie formatat pentru a-i ajusta dimensiunea, 

poziționarea, culoarea, a-i adăuga efecte etc. Pentru aceasta obiectul trebuie 

selectat. În momentul selectării unui obiect, în bara de meniu se activează un meniu 

specifiv de formatare: Drawing/Picture Tools → Share/Picture Format. De 

asemenea, se poate utiliza clic-dreapta și selecta din fereastra derulantă meniul 

pentru formatare formă (fig. 9). 

 

 

 

 

 

 

Fig. 7. 
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Fig. 9. 

Fig. 8. 
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Pentru a insera o imagine se acționează iconița/butonul Picture din meniul 

Insert. Se va deschide o fereastră de căutare de unde se selectează imaginea dorită, 

din dosarul în care se găsește depozitată pe hard-ul calculatorului sau pe alt suport de 

memorie, se selectează imaginea dorită și se acționează butonul Insert. Imaginea va 

fi lipită în diapozitivul prezentării, urmând a fi formatată după dorință.  

 Se recomandă inserarea imaginilor și nu copierea lor din alte prezentări sau 

programe Office, pentru a nu exista probleme de formatare în prezentarea care se 

crează, din cauza unor eventuale formatări redundante care se copiază odată cu 

imaginea. 

 

 Când se dorește inserarea unei forme desenate se acționează iconița Shapes = 

Forme din meniul Insert. Se derulează o fereastră din care se selectează forma ce 

urmează a fi inserată. Prompterul se transformă într-o cruce cu care se trasează 

chenarul formei în diapozitivul în care urmează a fi inserată. Ulterior forma poate fi 

repoziționată, redimensionată, formatată din punct de vedere al culorilor de linie și de 

umplutură, adăugarea de efecte de umbră, transparență etc. 

 

 Inserarea de diagrame presupune existența unui tabel de date pentru care se 

dorește obținerea diagramei. Se recomandă copierea unei diagrame existente dintr-un 

fișier Excel în diapozitivul PowerPoint. 

 

 Pentru inserarea unei casete-text se folosește iconița specifică din meniul 

Insert sau din submeniul Shapes. Se desenează o casetă în care se va începe 

introducerea textului. Dimensiunea se ajustează ulterior în funcție de mărimea 

textului și formatările acestuia. Formatarea casetei, separat de cea a textului, 

presupune dimensiunea, culoarea liniei și a fundalului, transparența fundalului casetei, 

mărimea distanțelor între text și marginile casetei, efecte adăugate casetei etc. 

  

Inserarea unei forme WordArt înseamnă de fapt inserarea unei casete-text în 

care se introduce un text cu formă artistică prestabilită, aleasă din meniu (fig. 10.). 

După introducerea textului, formatul acestuia poate fi schimbat, iar dimensiunea și 

tipul fontului se pot alege ca la oricare alt text.  

 

 

 

 

 

 

 Tot din meniul Insert se pot adăuga data și ora sau numărul diapozitivului. 

Acestea pot fi introduse separat sau cuprinse în Antet și sobsol, în conformitate cu  

dorința proiectantului prezentării, evident în funcție de necesitate. 

 

Textul dvs. aici 
Fig. 10. 
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2.5. Desenarea schemelor 

 

 Pentru a desena scheme care pot fi utile și sugestive în cadrul prezentării se 

folosesc formele puse la dispoziție în meniul Insert = Inserare → Shapes = Forme 

(poligoane, săgeți, linii simple sau cu săgeți în capete etc.). 

 Formele vor fi poziționate și dimensionate într-un diapozitiv conform schemei 

care se dorește a se desena. În fig. 11 se prezintă un exemplu de schemă cu diverse 

obiecte din submeniul Shapes = Forme. 

În funcție de modul în care se gândește animația pentru schemă (să apară în 

bloc sau pe elemente), unele elemente sau toate pot fi gruparte pentru a crea un 

singur obiect. Pentru aceasta se selectează obiectele respective și din meniul apărut 

la clic-dreapta se alege Group = Grupare. Operațiunea de anulare se face selectând 

obiectul și din meniul apărut la clic-dreapta se alege se va alege Ungroup = Anulare 

grupare. 

 Pentru a selecta mai multe obiecte se face clic pe primul, apoi cu tasta „Shift” 

apăsată se dă clic pe celelalte obiecte. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.6. Inserarea sunetelor, filmelor (formate audio, video) 

 

În PowerPoint există posibilitatea de a transforma o expunere de diapozitive 

într-o prezentare multimedia cu derulare automată prin adăugarea de sunete şi filme, 

crearea de legături către alte diapozitive şi setarea programării diapozitivelor. 

Sunetele şi filmele pot fi setate pentru a rula automat sau la comandă manuală. 

Inserarea sunetelor 

Sunetele inserate pot rula în timpul unei prezentări sau pot acompania 

tranziţiile diapozitivelor.  

Inserarea sunetelor se realizează din meniul Insert → Media → Audio. Se pot 

insera fișiere audio din calculator, miniaturi audio ale programului sau se pot realiza 

înregistrări audio. 

test 

Fig. 11. 
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PowerPoint inserează sunete/înregistrări audio ca obiecte ce pot fi apoi 

modificate şi editate. După inserarea unui obiect-sunet, pot fi modificate opţiunile de 

rulare. Pentru a fi auzite înregistrările audio dintr-o prezentare powerpoint trebuie 

să existe boxe conectate la calculator.  

 Setările privind modul de redare a sunetelor: la tranziția diapozitivelor, în 

timpul prezentării (pe durata expunerii unui diapozitiv, mai multor diapozitive sau până 

la terminarea prezentării) se ajustează în momentul proiectării tranziției 

diapozitivelor și a animației obiectelor.  

 Inserarea filmelor 

 Inserarea filmelor se realizează din meniul Insert → Media → Video. Se pot 

insera fișiere video din calculator, miniaturi video ale programului sau fișiere video din 

pagini web. 

 PowerPoint inserează filmele ca obiecte. După inserarea unui obiect-video, pot 

fi modificate opţiunile de rulare prin modificarea efectelor de animație 

particularizate și a opțiunilor filmului. 

 

2.7. Înregistrarea unei narațiuni într-o expunere de diapozitive 

 

 Pentru a înregistra o naraţiune este nevoie de un microfon la computer. Este 

posibilă înregistrarea unei naraţiuni înainte de a rula o expunere de diapozitive sau să 

fie înregistrată în timpul prezentării cu includerea și a comentariile participanţilor. În 

timpul înregistrării naraţiunii, aceasta poate fi întreruptă sau oprită în orice moment. 

O narațiune vocală poate fi ștearsă la fel ca orice alt obiect PowerPoint. 

 Pentru a realiza o narațiune vocală în PowerPoint se utilizează comanda Record 

audio din meniul Insert → Media → Audio sau din meniul Record → Auto-play Media 

→ Audio. Se deschide caseta de dialog Record Sound = Înregistrare sunet (fig. 12.). 

 Se poate da un nume înregistrării, în locul destinat acestuia din caseta de 

dialog. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

Înregistrare Oprire Redare 

Fig. 12. 
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Pentru începerea înregistrării narațiunii audio se apasă butonul „Înregistrare” 

din caseta de dialog. Durata sau lungimea înregistrării este cronometrată în casetă. 

Narațiunea se oprește de la butonul „Oprire” iar la clic pe „OK” va apărea o iconiță 

audio (un difuzor) în diapozitivul prezentării (fig. 13.). Pentru redare în vederea 

verificării se folosește butonul din caseta de înregistrare (fig. 12.). 

 Pentru redarea narațiunii în cadrul prezentării se folosește butonul de rulare 

atașat înregistrării din diapozitiv (fig. 13). 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Formatarea se face din meniul „Format” și/sau „Redare”. Calculatorul trebuie să 

aibă atașate boxe pentru a putea fi recepționată înregistrarea audio de către 

participanți. 

 

2.8. Inserare link-urilor web 

  

 Într-o prezentare, dacă se dorește accesarea unei surse web, se copiază adresa 

web și se include în diapozitiv într-o casetă-text. În timpul expunerii diapozitivelor, la 

clic pe adresă sau la programare automată (în momentul de timp programat sau la 

apariția diapozitivului) se va accesa pagina web respectivă. Este obligatorie în acest 

caz conexiunea calculatorului la internet. 

Fig. 13. 

Redare/Pauză 
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3. Animația 
 

Pentru a face expunerile de diapozitive mai atractive şi mai interesante, se pot 

adăuga animaţii textului şi obiectelor din diapozitiv, pentru a programa momentul și 

modul lor de afişate în timpul expunerii prezentării. De asemenea, tranziția de la un 

diapozitiv la altul poate fi făcută cu diferite efecte de animație. 

 

3.1. Animația de tranziție între diapozitive 

 

Tranziţia între diapozitive este efectul vizual al unui diapozitiv pe măsură ce 

apare şi dispare de pe ecran în timpul unei expuneri de diapozitive. 

Pentru a seta o tranziţie pentru un diapozitiv sau pentru un grup de diapozitive, 

acesta va fi selectat/ acestea vor fi selectate în fila „Sortare diapozitive” sau în fila 

„Diapozitive” din modul de vizualizarea „Normal”, apoi se aplică tranziţia dorită din 

meniul „Tranziții” (fig. 14.).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Fig. 14. 

Meniu 

Zona cuprinsului 

diapozitivelor 

Diapozitive selectate 

modul de vizualizarea „Normal” 

Avansare diapozitive 
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 Pentru a selecta mai multe diapozitive se folosește tasta „Ctrl”. 

De asemenea, din meniu este posibilă setarea duratei, a direcţiei tranziţiei şi a 

momentului tranziţiei.  

Dacă se aplică atât un efect de tranziţie cât şi un efect de animaţie unui 

diapozitiv, efectul de tranziţie va avea loc primul, urmat de efectul de animaţie. 

 

3.2. Animația obiectelor 

 

Expunerea diapozitivelor unei prezentări PowerPoint poate fi mai atrăgătoare şi 

mai interesantă  prin folosirea animaţie obiectelor din diapozitive. De asemenea, un 

efect de animație poate marca un anumit moment sau subiect al prezentării. 

Obiectele dintr-un diapozitiv pot apărea în prezentare odată cu apariția 

diapozitivului, dacă nu este atașată nici o anumație. Pot apărea fiecare la clic de 

mouse, dacă s-a setat acest lucru, fără altă animație, sau pot apărea la clic de mouse 

sau automat cu temporizare și animația atașată, în funcție de modul de proiectare a 

prezentării. 

 Pentru a atașa animație unui obiect se alege diapozitivul în care se află obiectul, 

apoi se selectează obiectul și se aleg efectele dorite utilizând opțiunile disponibile în  

meniul Animations = Animații (fig. 15.). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Fig. 15. 
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 Unui obiect i se pot atașa efecte de intrare, de ieșire sau de accentuare a 

animației. Se poate seta și calea de mișcare. 

 Animația și apariția obiectului în prezentare în timpul expunerii se poate face la 

clic de mouse sau automat, opțiuni care se selectează după ce s-a ales tipul animației. 

Se setează de asemenea și durata animației și durata întârzierii apariției. 

 Procesul de atașare a efectelor de animație se repetă pe rând pentru fiecare 

obiect în funcție de modul de proiectare a expunerii, care trebuie să fie perfect în 

acord cu susținerea prezentării de către autor. 

 Caseta-text este considerată un obiect căruia i se poate atașa animație 

conform celor prezentate mai sus. În plus se poate specifica modul de apariție a 

conținutului casetet-text (a textului) de la iconița „Effect Options”: în bloc sau pe 

paragrafe sau cuvinte. 

 Atunci când prezentarea conține o schemă desenată cu obiectele proprii 

programului, în funcție de modul cel mai potrivit, elementele schemei pot apărea pe 

rând, cu animație și temporizare, sau toată schema poate apărea în bloc. În acest 

ultim caz se recomandă selectarea tuturor elementelor care compun schema (se face 

clic pe fiecare ținând tasta „Shift” apăsată) și gruparea lor (clic-dreapta și alegere 

„Group = Grupare” din meniul derulant) într-un singur obiect, astfel aplicându-se un 

singur proces de animație schemei tratată ca un obiect compact.  

 Pentru obiectele „filme” și „audio”, la inserate lor într-o prezentare trebuie 

avută în vedere corelarea setărilor de animație cu cele de redare audio/video. Se pot 

utiliza opțiunile din panoul de animație afișat în dreapta diapozitivului (fig. 16).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Fig. 16. 
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3.3. Setarea programării diapozitivelor 

 

Programarea diapozitivelor se referă la durata de timp cât un diapozitiv apare 

pe ecran. La fel ca în cazul tranziţiilor, setarea programării diapozitivelor se poate 

face pentru un diapozitiv sau un grup de diapozitive, în funcţie de câte diapozitive 

sunt selectate atunci când se aplică programarea. 

Există două modalităţi de a avansa în expunerea de diapozitive: avansare 

automată, care se setează prin caracteristica de programare; sau avansare manuală, 

efectuată cu clic de mouse sau utilizând oricare dintre tastele „Spațiu” sau „săgeată-

stânga”. 

Caracteristica automată de programare a avansării schimbă diapozitivele în 

expunerea de diapozitive, menţinând fiecare diapozitiv pe ecran pentru durata de 

timp selectată dinainte (vesi fig. 14.): se face din meniul Transitions → Avansare 

diapozitiv = Advance Slide. 

 

3.4. Expunerea diapozitivelor 

 

În timpul elaborării unei prezentări, în orice moment există posibilitatea de a 

revedea diapozitivele rapid şi cu uşurinţă  pentru verificarea corectitudinii şi a 

cursivităţii, din meniul Slide Show = Expunere diapozitive (fig. 17.).  

 Se poare reda expunerea fie de la diapozitivul curent, fie de la începutul 

prezentării, pentru verificarea expunerii în sau până în momentul elaborării ei și a 

corectitudinii proiectării animației.  

 

Există și varianta de creare a unei prezentări cu navigare automată. Expunerile 

de diapozitive cu rulare automată sunt un mod foarte bun de a comunica informaţii 

fără a avea nevoie de cineva care să ruleze expunerea. Este posibilă configurarea unei 

prezentări pentru a rula fără supraveghere într-un stand la o expoziţie sau pentru a o 

amplasa pe intranetul firmei pentru a rula după placul utilizatorului. În acest caz se 

setează avansarea diapozitivelor prezentată la punctul 3.3, din Tranziții → Avansare 

diapozitiv.  

 

Pentru ca prezentarea să ruleze în buclă, fără oprire, se vor utiliza setările din 

meniul Slide Show = Expunere diapozitive → Set Up Show = Setare expunere 

diapozitive (fig. 18.). Se deschide fereastra de configurare de unde se setează 

opțiunile dorite și pentru a fi reluată continuu se bifează „Loop continuously until ESC 

(Ciclează continuu până la ESC)”. 

  

 Orice expunere se întrerupe în orice moment utilizând tasta „ESC”. 
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Fig. 18. 

Fig. 17. 
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4. Salvarea în diferite formate 
 

 La punctul 1.3. s-a prezentat operațiune de salvare sub altă denumire sau alt 

format prin utilizarea funcției „Save as = Salvare ca”. 

 În capitolul prezent se va insista asupra funcției „Save as”, pentru formatele 

cele mai des utilizate, și a modului în care se poate realiza și cum trebuie să fie o 

prezentare pentru ca fișierul salvat într-unul dintre formatele disponibile să fie optim 

pentru o utilizare ulterioară. Se utilizează listas propusă de program pentru salvarea 

în diferite tipuri de formate „Save as type” (vezi fig. 4). 

 

4.1. Formatul specific de prezentare PowerPoint: pptx, ppt 

 Orice prezentare PowerPoint salvată într-un fișier va avea extensia „.pptx” 

dacă este creat cu o aplicație de la varianta 2007 sau mai recentă, și extensia „.ppt” 

dacă este utilizat programul mai vechi. 

 Un fișier creat cu o variantă de program mai recentă nu poate fi deschis cu 

varianta de program mai veche decât Office 2003, de aceea, pentru a putea folosi 

prezentări noi spre a fi rulate cu programul mai vechi, este necesară salvarea 

fișierului și în modul compatibil cu varianta 97-2003. Acest lucru se realizează 

folosind funcția „Salvare ca” și selectând tipul de program. Astfel, noul fișier va primi 

extensia „.ppt” și va putea rula și cu varianta veche de program. 

 Invers, orice program varianta „.ppt” poate fi deschis și rulat cu varianta de la 

2007 în sus, dar, uneori se poate întâmpla să trebuiască refăcute unele animații sau 

comenzi pentru a fi conforme cu varianta de program folosită. 

 

4.2. Formatul de document imprimabil: pdf 

 Formatul pdf transformă prezentarea într-un document care poate fi consultat 

utilizând programele de citire de documente tip pdf, și nu va fi necesar un program 

PowerPoint. La salvarea în format pdf trebuie bifate opțiunile dorite din caseta de 

dialog, precum și dacă se dorește apariția notelor pe pagina documentului.  

Fișierul în format pdf poate avea doar un diapozitiv pe pagină sau mai multe, în 

funcție de posibilitățile oferite de program, dar, în cazul în care se va salva în 

varianta unui singur diapozitiv pe pagină, se poate selecta la imprimare numărul de 

diapozitive care să fie imprimate pe o pagină.  

Se poate salva în fișier pdf și un număr de diapozitive care au fost selectate în 

prealabil (utilizând tasta „Ctrl”), caz în care se selectează din opțiunile de salvare 

varianta „Selection”. 

Un fișier pdf are dimensiune mult mai mică decât unul pptx și de asemenea 

poate fi ușor de trimis, de tipărit și de consultat. Dacă se aduc modificări prezentării  

altele decât animații (în text, imagini etc.), va fi nevoie de o nouă salvare a prezentării 

în format pdf pentru a avea ultimele modificări cuprinse în document.  
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 La tipărire există posibilitatea de a imprima un singur diapozitiv pe pagină, sau 

mai multe, din opțiunile de imprimare. 

 

4.3. Formatul de prezentare tip expunere: ppsx, pps 

 O prezentare PowerPoint poate fi salvată ca expunere, respectiv ca format 

ppsx/pps. În acest format este salvată expunerea prezentării. La deschiderea 

fișierului, acesta rulează ca expunere și nu se poate interveni în cuprinsul ei pentru 

modificări. Dacă s-a făcut animație, aceasta rulează automat sau la clic, așa cum a 

fost proiectată. 

 Din nou, dacă se aduc modificări prezentării va fi nevoie de o nouă salvare a 

acesteia în format ppsx/pps. 

 

4.4. Formatul imagine: gif, jpg, png, tif, bmp 

 Diapozitivele unei prezentări PowerPoint pot fi salvate sub formă de imagini, în 

diferite formate, în funcție de necesitate. La salvare există posibilitatea de salvare 

doar a diapozitivului selectat sau a întregii prezentări. În acest ultim caz imaginile 

corespunzătoare fiecărui diapozitiv în parte sunt salvate într-un dosar cu numele 

stabilit, imaginile primind numele „Slide1”, „Slide2” etc. 

 

4.5. Formatul video: mp4, wmv 

 O prezentare PowerPoint se poate salva în format video: wmv, mp4. Office 2010 

nu are posibilitate de salvare ca mp4, doar wmv. Variantele următoare de office au 

însă această posibilitate. Un format video wmv poate rula cu Windows Media Player, 

propriu sistemului de operare Windows și deci existent pe toate calculatoarele cu 

acest sistem de operare; nu este nevoie de programul PowerPoint pentru vizualizare, 

ca în cazul formatelor pptx/ppt și ppsx/pps. Diferența de rulare între un fișier wmv și 

unul ppsx/pps este că în formatul pps se avansează cu clic în cadrul expunerii, acolo 

unde în ppt era setat acest lucru, în timp ce în formatul wmv se avansează automat de 

la cap la coadă, inclusiv în cazul în care s-a proiectat avansarea la clic de mouse. 

Astfel, pentru a fi o avansare reușită în format video, va trebuit proiectată o 

avansare automatizată pentru fiecare obiect, și corect temporizată pentru ca 

expunerea să poată fi urmărită și citită în mod optim. 

 Formatul mp4 este un format video mai avansat. Expunerea astfel salvată 

rulează și cu Windows Media Player dacă acesta poate citi acest tip de fișiere, sau cu 

un Media Player mai evoluat. 

 

4.6. Formatul pentru web: xml 

 Formatul xml este un format utilizat pentru pagini web sau diferite programe 

care îl folosesc ca limbaj de proiectare. Se salvează în acest format doar când este o 

solicitare specificată în acest sens. 
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